Importing PinPointer® Data Into Act!
Note: These instructions were written for Act! 2000. Other versions may be different.

1) Export your ePinPointer data to Excel.
2) From the Search Criteria Screen click on “Save to Excel”

g [m [

2. ePinPointer - Search Criteria

" Company Name: Contact Name: Street Name: - =
J s
Click on column heading to sort by
Chanse Gity (ies) | | vI [ «]
Mewell Rubbermaid{Phil Clouse 330-264-6464 |Wooster _|
Ehﬁ°ii ;H EEHE Ei} | lﬁ Gerstenslager Tom &shby 330-262-2015 |Wooster
Luk Inc Raymund Heinen |330-264-4383 |Wooster
E - i E | || lﬁ Crown Morth AmeriiMike Hooper 330-262-6010 |Wooster
Bosch Rexroth Corglarry Ouwerkerk [330-263-3300 [Wooster
Wooster Brush Co |lames Riggs 330-264-4440 |Wooster
W I | Frito-Lay Inc Jim Barnard 330-262-1070 |Wooster
: Stahl, Scott A, FetzdSteve Rowe 330-264-7441 |Wooster
W I 'l akron Brass Co Brian Hungerman [330-264-5678 |Wwooster
Bell & Howell Public)andy wyszkowski|330-264-6666 [Wooster
Mumber of Emplayess: | = Arbartech Keith Barr 330-264-4266 |Waoster
Timken Co, The Jeff Hoer 330-264-1122 |Wooster
Type of Product: I Metals USA/Wooste|Don Gingery 330-264-8416 |Wooster
. Seaman Corp, IndulDave Slater 330-262-1111 |Wooster
Select Field: TEIEEE SEETE | " Daily Reco|Rhonda Geer 330-264-1125 |Wooster
| =l | CNC Metal Products|Kim ¥antal 330-264-6640_|Waoster
and above International Paper|lames Gracey 330-264-1322 |Wooster
ﬁEH ii | Undo | Metromedia Techno|Ralph A, Gillota [330-264-2501 [Wooster
F1 Designs Darcy Pajak 330-264-1377 |Wooster
Buckeye Container |T. 1. Shea 330-264-6336 |Wooster
M & Earmparizs: IT Rayco Mfg Inc JR. E-m-\llling 330-264-8699 |Wooster
Bauer Corp Fon Smith 330-262-3070 |Wooster -
Enter % of companies 4 >
to be filtergd out: o m




3) Save the exported data in your “My Documents” folder. Give it an easy to
remember name. For this example we will use “epin-
export.xls”

Save i IaMy Dacuments j . ﬁ( ,

Higtary

i |weborders

File name: Iepin-e:-:p-:urﬂ:-cls j Save
=

Cancel |
F

Save as lype: I Microzoft Excel [*.xl)

4) Close PinPointer and open the exported file in Microsoft Excel.



5)

6)

Your screen should look something

Ed Microsoft Excel - ExcelH.csv

J Eile Edit ¥ew Insert Format Tools Data ‘Window Help

like this:

DEES SRy | BB -8 8l -w-|B U=
Al Jhd| = Source
A | B | ¢ | o | E | F c | H | 1 | 4 KoL M 3
1 [Source  lAcctin  Company [Division Ne Address  City State Zip Plus4 County  |Po Box  Mailing Cit Mailing StiMailing Zip Mail Zip E3Ma

| 2 |Harris Pink 5108401 Aggregate Industries | 1705 S Ac Denver co 0223 3603 Denver PO Box 5 Denver co goz209
| 3 |Harris Pinf 8446443 Hawkeye Infarmation | 2115 W M Fort Collin: CO 80521 3220 Larimer  |PO Box 21Fort Callin: CO 80522
| 4 |Harris Pink 8446471 Interpex Ltd 7156 14th £ Galden  CO 80401 1906 Jefferson | PO Box 82 Galden  CO 80402
| & |Harris Pinf 9086411 Coherent Technologie 555 Aspen Lafayette (GO 80026 9341 Boulder  |PO Box 7£Boulder GO 80306
| B [Harris Pinf 9092052 HYWI 5563 Weld Frederick |CO 80530 237 Weld PO Box 2ZFrederick |CO 80530
| 7 |Harris PinfF 9086231 Agripro Yheat Co (806 M 2nd Berthoud CO 80513 30 Larimer PO Box 30Berthoud CO 80513
| B |Harris Pink 9067173 Telluride Institute Inc | 283 5 Fir | Telluride  CO 81435 1770 Zan Migug PO Box 17 Telluride  CO 81435
| 9 |Harris Pinf 9085707 Johns Manville Corp 10100 W L Littleton GO BO127 5002 | Jeffersan |PO Box BZLittleton GO 80162
| 10 |Harris Pinf 9085557 | Clifford Consulting & F2275 Wayi Colorado SCO 80915 1635 El Paso PO Box 17 Colorado SCO B0935
| 11 |Harris Pink 8948098 Emerging Technology 1065958 Dee Franktown CO 80116 Douglas PO Box 10Franktown CO 80116
| 12 |Harris Pink 9085995 CoorsTek Analytical LE00 Sth St Galden  CO 80401 1060 Jeffersan | PO Box 40 Galden  CO 80401
| 13 |Harris Pinf 9086126 Siegel Oil Ca 1380 Zuni Denver GO 80204 2364 Denver  |PO Box 40 Denver GO 80204
| 14 |Harris Pinf 9119726 Aerospace Design & (14377 Me: Longmont | CO 80504 Wield PO Box 67 Miwot co G0544
| 15 |Harris Pinf 9068215 kaman Instrumentatic 3450 N Ne Colorado SCO 80907 5331 El Paso  |PO Box 32 Colorado 2C0 80933
| 16 |Harris Pinf 9088361 CQG Inc 1080 17th Denver  CO 80265 2077 Derwer  |PO Box TEDenver  CO 80201
| 17 |Harris Pinf 5446415 Bruce Bell & Assocs (425 Main £ Canon City CO 81212 3778 Fremaont PO Box 40 Canon City CO 81215
| 18 |Harris Pinf 8446538 Western Yares 3100 CounMNorwood | CO 81423 BY3 San Migue PO Box C MNorwood |[CO 81423
| 19 |Harris Pink 5446553 3T Software 48585 PearlBoulder  CO 80301 2492 Boulder  |PO Box 1€Boulder | CO 80308
| 20 |Harris Pink 8446563 Masque Publishing In 7006 5 Alt Englewooc CO 80112 2015 Arapahoe PO Box 52 Englewooc GO 80155
| 21 |Harris Pinf 5446644 Wild Hare Computer £575 Burbhal Broomfield CO 80020 1666 Boulder PO Box 32 Boulder | CO 80307
| 22 |Harris Pinf 8446694 CQG Inc 201 CentelGlenwood CO 81601 2868 | Garfield  |PO Box 7% Glenwood | CO 81602
| 23 |Harris Pinf 90850390 Advanced DB Master 724 5 Tejo Colorado SCO 80903 4057 El Paso  |PO Box 12 Colorado 2C0O 80901
| 24 |Harris Pinf 9085094 Handley Computer Cc 185 Eldora Boulder  CO 80303 3039 Boulder PO Box 30Boulder GO 80307
| 25 |Harris Pinf 9085712 TurboPower Software | 4775 Centi Colorado SC0 80319 3309 El Paso  |PO Box 45 Colorado SC0 80349
| 26 |Harris Pinf 9085816 Animas Autormnation & 107 W 19t Durango | CO 81301 5011 La Plata PO Box 2EDurango  CO G1302
| 27 |Harris Pinf 9086038 ARC Science Simulat306 M WasLoveland CO 80537 5766 Larimer  |PO Box 1¢Laveland | CO 80539
| 28 |Harris Pink 9086070 Realfast Software Puk721 Granit Frisco co 80443 4700 Summit PO Box 47 Frisco co 80443
| 29 |Harris Pinf 9086245 Starplay Productions 5188 Suns Boulder (GO 80302 8753 Boulder  |PO Box 15Boulder GO 80308
| 30 |Harris Pink 9087543 Cybemetics Inc 743 Honzo Grand Juni CO 81506 8717 Mesa PO Box B[ Grand Juni CO 81506
| 31 |Harris Pink 9087857 Musick International |113 CentelBuena Vis CO g1211 Chaffee PO Box 12Buena Vis CO g1211
| 32 |Harris Pink 9088428 Campulink 457 Spring Silvertharn GO 80498 437 Summit PO Box 42 Silverthorn ©O 80498
| 33 |Harris Pinf 9083051 Data West Corp 1061 E 2niDurango CO 81301 5112 La Plata  |PO Box 15Durangn GO 81302
| 34 |Harris Pinf 90390118 Alpha Byte Systerns 910 Resca Silverthomn CO G048 969 Surnmit PO Box SEDillon co 80435
| 35 |Harris PinfF 9090423 Eagle Computer Syst 120 E 3rd |Eagle 0] 81631 Eagle PO Box 10Eagle 0] 81631
14 [a[b il Enceln IET}
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Select the entire spreadsheet by clicking the gray box above “1” and to the left of
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7) Your screen should now look similar to this:

Ed Microsoft Excel - ExcelH.csv

J Eile Edit ¥ew Insert Format Tools Data ‘Window Help

DeEe ey | s2as o-(ws: s |aa?

J Arial

Acctho  Company | Division N: Address  City State Plus4 County  Po Box  Mailing Cit Mailing St: Mailing Zip Mail Zip E: Ma

Harris Pink 6108401 Aggregate Industries [1705 3 Ac Denver co 0223 3603 Denver PO Box 52 Denver co g0209
Harris Pinf 8446443 Hawkeye Information 2115 W M Fort Collin: O 80521 3220 Larimer PO Box 21Fort Collin: CO 80522
Hartis Pinf 8446471 Interpex Ltd 715 14th SGolden GO 80401 1906 Jefferson PO Box 8: Golden  CO g0402
Hartis Pinf 9086411 Coherent Technologie 655 Aspen Lafayette CO 80026 9341 Boulder PO Box 7£Boulder  CO 80306
Harris Pinf 9092052 Hyyl 5963 Weld Frederick CO 80530 237 Weld PO Box 22 Frederick CO 80530
Harris Pinf 2086231 Agripro ¥wheat Co 806 N 2nd Berthoud €O 80513 30 Larimer PO Box 30 Berthoud CO 80513
Hartis Pinf 2087173 Telluride Institute Inc 283 5 Fir  Telluride  ©O 81435 1770 San Migue PO Box 17 Telluride  CO 81435
Hartis Pinf 9089707 Johns Manville Corp 10100 W L Littleton  CO 80127 5002 Jefferson PO Box BzLittleton  CO 80162
Harris Pink 9085557 Clifford Consulting & F2275 YWay Colorado £ CO 80915 1635 El Paso PO Box 137 Colorado SCO g0935
Harris Pinf 8349096 Emerging Technology 10698 Dee Franktown CO 80116 Douglas PO Box 1CFranktown CO 80116
Hartis Pinf 2085295 CoorsTek Analytical LB00 9th St Golden  CO 80401 1050 Jefferson PO Box 40 Golden  CO 80401
Hartis Pinf 9086126 Siegel Oil Co 1380 Zuni Derver  CO 80204 2364 Denver PO Box 4LDenver  CO 80204
Harris Pink 9119726 Aerospace Design & 114377 Me: Longmont CO g0504 Wield PO Box 67 Miwot co B0544
Harris Pinf 9088215 Kaman Instrumentatic 3450 N Me Colorado S C0O 80207 5331 El Paso PO Box 32 Colorado SCO 80933
Harris Pinf 9088361 CQG Inc 1050 17th Denver GO 80265 2077 Denver PO Box 7EDenver GO 50201
Hartis Pinf 8446415 Bruce Bell & Assocs 425 Main £ Canon City CO 81212 3778 Fremaont PO Box 40 Canon City CO 81215
Harris Pink 8446538 YWestern WWares 3100 Coun Morwood  CO 81423 B93 San Migue PO Box C Norwood  CO 81423
Harris Pinf 8446553 XMT Software 4585 PearlBoulder €O 50301 2492 Boulder PO Box 1€ Boulder €O 80308
Hartis Pinf 8448563 Masque Publishing In 7006 S Alt Englewooc GO 80112 2015 Arapahoe PO Box 52 Englewooe GO 80155
Hartis Pinf 8446644 WWild Hare Camputer $575 Burbal Broomfield CO B0020 1666 Boulder PO Box 32 Boulder  CO 80307
Harris Pinf 8446694 CQG Inc 201 Centel Glenwood CO 81601 2068 Garfield PO Box 72 Glenwood CO G1602
Harris Pinf 2085090 Advanced DB Master 724 5 Tejo Colorado SCO 80503 4057 El Paso PO Box 12 Colorado S CO 80901
Hartis Pinf 2085094 Handley Computer Cc 155 Eldora Boulder  CO 80303 3039 Boulder PO Box 3L Boulder GO 80307
Hartis Pinf 9085712 TurboPower Software 4775 Cent Colorado SCO 80919 3309 El Paso PO Box 45 Colorada ECO 80949
Harris Pink 9085816 Anirmas Autormation & 107 W 19t Durango CO 81301 5011 La Plata PO Box 26 Durango  CO g1302
Harris Pinf 9086035 ARC Science Simulat 306 M ¥WasLoveland €O 80537 5765 Larimer PO Box 1¢Loveland €O 80539
Harris Pinf 9086070 Realfast Software Put 721 Granit Frisco (0] 50443 4700 Summit PO Box 47 Frisco (0] 50443
Hartis Pinf 9086245 Starplay Productions 51858 Suns Boulder  CO 80302 8753 Boulder PO Box 1€Boulder  CO 80308
Harris Pink 9087543 Cybernetics Inc 743 Horizo Grand Jun CO 81506 8717 Mesa PO Box BL Grand Jurn CO 81506
Harris Pinf 9087587 Musick International 113 Centel Buena Yis CO 81211 Chafiee PO Box 12 Buena Yis CO 81211
Hartis Pinf 2088429 Compulink 457 Spring Silvertharn GO 80498 437 Summit PO Box 42 Silverthorn CO 80498
Hartis Pinf 9089051 Data West Corp 1061 E 2riDurango CO 81301 5112 La Plata PO Box 1€Durangn CO 81302
Harris Pink 9090118 Alpha Byte Systerms 910 Resco Silverthom CO g04598 969 Surnmit PO Box SE Dillon co 80435
Harris Pinf 2090423 Eagle Computer Syst 120 E 3rd Eagle [&:0] 81631 Eagle PO Box 1LEagle [&:0] 81631
1l
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8) From Excel’s menu, select Format -> Column -> Autofit Selection. As
shown in this example:

Microsoft Excel - ExcelH.csv

J File Edit ¥iew Insert | Format Tools Data MWindow Help

I EIEE it @ = A 4| @3] - -
Al = Row H
A B C 3 A =

Source  Accthlo L b Zip Plus4 County  Po Box  Mailing Cit Mailing St: Mailing Zip Mail Zip E: Mg
Haris Pinf 6108400 80223 3603 Denver PO Box % Denver  CO 60209
Harris Pinf g44p447 ~ Actofermat.. ' ‘ B0521 3220 Larimer PO Box 21Fort Collin: GO B0522
Harris Pinf 544471 ~ CondtonalFormatting... by ¢ golgen  ©O) 80401 1906 Jefferson PO Box 82 Golden  ©O 80402
Harris Pinf 9086411 ¥ spen Lafayette CO B0026 9341 Boulder PO Box 7¢Boulder CO 80306
Harris Pinf 9092052 Hy\l 5863 WWeld Frederick CO 80530 237 Weld PO Box 22 Frederick €O 80530
Hartis Pinf 2086231 Agripro Ywheat Co 806 N 2nd Berthoud ©O 80513 30 Larimer PO Box 30 Berthoud CO 80513
Hartis Pinf 9087173 Telluride Institute Inc 283 5 Fir  Telluride CO 81435 1770 San Migue PO Box 17 Telluride  CO 81435
Harris Pink 9089707 Johns Mamalle Corp 10100 W L Littleton  CO 80127 002 Jefferson PO Box B2 Liftleton  CO 80162
Harris Pinf 2085557 Clifford Consulting & F2275 Way Colorado SCO 80915 1635 El Paso PO Box 17 Colorado SCO 80935
Hartis Pinf 8949096 Emerging Technology 10698 Dee Franktown GO 80116 Douglas PO Box 1CFranktown GO 80116
Hartis Pinf 9085295 CoorsTek Analytical LBO00 9th St Golden €O 80401 1050 Jefferson PO Box 40 Golden €O 80401
Harris Pink 9086126 Siegel Oil Co 1380 Zuni Denver co g0204 2364 Denver PO Box AC Denver co g0204
Harris Pinf 2119726 Aerospace Design & 14377 Me: Longmont O 80504 Weld PO Box 57 Miwot [&:0] B0544
Harris Pinf 9088215 Kaman Instrumentatic 3450 N MNe Colorado £ GO 50207 5331 El Paso PO Box 32 Colorado £CO 80933
Hartis Pinf 9088351 CQG Inc 1050 17th Denver co 80265 2077 Denver PO Box 7£ Denver co 80201
Harris Pink 8446415 Bruce Bell & Assocs 425 Main £ Canon City CO g81212 3778 Frernont PO Box 40 Canon City CO 81215
Harris Pinf 8446538 YWestern YWares 3100 CounMorwood  CO 81423 B93 San Migus PO Box C Norwood  CO 81423
Harris Pinf 8446553 #MT Software 4585 Pear|Boulder €O 80301 2492 Boulder PO Box 1€ Boulder  CO 80308
Hartis Pinf 8446563 Masque Publishing In 7006 S Alt Englewooc CO 80112 2015 Arapahoe PO Box 52 Englewooe CO 80155
Harris Pink  B44B644 YYild Hare Computer £575 Burba Broormfield CO g0020 1666 Boulder PO Box 32 Boulder CO 80307
Harris Pinf 8446694 CQG Inc 201 Centel Glenwood CO 51601 2868 Garfield PO Box 7f Glenwood CO 51602
Hartis Pinf 2085090 Advanced DB Master 724 5 Tejo Colorado SCO 80503 4057 El Paso PO Box 12 Colorado £ GO 80901
Hartis Pinf 9085094 Handley Computer Cc 155 Eldara Boulder O 80303 3039 Boulder PO Box 30 Boulder  CO 80307
Harris Pinf 9085712 TurboPower Software 4775 Cent Colorada SCO 80919 3309 El Paso PO Box 45 Colorada S CO G0249
Harris Pinf 2085816 Animas Automation & 107 ¥ 19t Durango O 81301 5011 La Plata PO Box 2tDurango  CO 81302
Harris Pinf 9086035 ARC Science Simulat 306 M ¥Wa:Loveland  CO 80537 5765 Larimer PO Box 1¢Loveland GO 80539
Hartis Pinf 9086070 Realfast Software Put 721 Granit Frisco co B0443 4700 Summit PO Box 47 Frisco co B0443
Harris Pink 9086245 Starplay Productions 5188 Suns Boulder  CO g0302 8753 Boulder PO Box 15Boulder  CO 80308
Harris Pinf 2087543 Cybemetics Inc 743 Horizo Grand Juni CO 81506 9717 Mesa PO Box B Grand Juni CO 51506
Harris Pinf 9087587 Musick Interational 113 Centel Buena Yis GO 81211 Chaffee PO Box 12 Buena Yis CO 81211
Hartis Pinf 2088429 Compulink 457 Spring Silvertharn CO 80498 437 Summit PO Box 42 Silverthorn CO 80498
Harris Pink 9089051 Data West Corp 1061 E 2 Durango CO 81301 5112 La Plata PO Box 15Durango CO 81302
Harris Pinf 2090118 Alpha Byte Systems 910 Resco Silverthormn CO 80498 569 Summit PO Box SEDillon [&:0] 80435
Hartis Pinf 2090423 Eagle Computer Syst 120 E 3rd Eagle [#0] 81631 Eagle PO Box 1CEagle [#0] 81631
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9) Click on any cell in the worksheet to turn off the selection. Your screen should
look similar to this:

Ed Microsoft Excel - ExcelK.csv =] x]
J File Edit Wew Insert Format Tools Data Window Help ;Iilﬂ
DRSSy ¥ 2RT 9@ = & 4|l @7 - - |B 7D
Al | = Source
A | B | C [ i} | E [ F [& ]
1 |Source |AcctMo | Company Division Mame Address1 City State Zip

| 2 |Harris PinPainter | 5108401 Aggregate Industries Inc 1705 5 Acoma St Denver [#0]

| 3 |Harris PinPainter 8446443 Hawkeye Information Systems 2115 W Mulberry St Fart Callins co

| 4 |Harris PinPointer 8446471 Interpex Ltd 715 14th S5t Golden co

| & |Harris PinPainter | 9086411 Coherent Technologies Inc 555 Aspen Ridge Dr Lafayette 0]

| B |Harris PinPainter | 9092062 Hyv| 5963 Weld County Road 16 Frederick co

| 7 |Harris PinPaointer 9086231 Agripro Wheat Co 806 N 2nd St Berthoud co

| 8 |Harris PinPainter 9087173 Tellunde Institute Inc 283 S Fir Telluride co

| 9 |Harris PinPainter | 9083707 Johns Manville Corp 10100 W Ute Ave Littleton co

| 10 |Harris PinPainter | 9085557 Clifford Consulting & Research 2275 Waynoka Rd #.J Colorado Springs CO

| 11 |Harris PinPainter 8349096 Emerging Technology Solutions 10698 Deetfield Rd Franktown co

| 12 |Harris PinPainter | 9085995 CoaorsTek Analytical Labs B00 9th St Golden co

| 13 |Harris PinPainter | 9086126 Siegel Oil Co 1380 Zuni 3t Denver co

| 14 |Harris PinPainter | 9119726 Aerospace Design & Development 14377 Wead 5t Langrant [#0]

| 15 |Harris PinPainter 9086215 Kaman Instrumentation Opers 3450 M Nevada Ave Colorado Springs CO

| 16 |Harris PinPointer | 9086367 CQG Inc 1050 17th St # 2000 Denver co

| 17 |Harris PinPainter | 8446415 Bruce Bell & Assocs 425 Main 3t #10 Canan City co

| 18 |Harris PinPainter | 5446538 YWestern Wares 3100 County Road 4325 Marwood co

| 19 |Harris PinPainter 8446553 =T Software 4888 Pearl East Cir #110 Boulder co

| 20 |Harris PinPointer | 8446563 Masque Publishing Inc 7006 S Alton Way # A Englewnod co

| 21 |Harris PinPainter | 8446644 YYild Hare Computer Systems Inc 575 Burbank St#E Broomfield 0]

| 22 |Harris PinPainter | 8446654 CQG Inc 201 Centennial Dr Glenwood Springs  CO

| 23 |Harris PinPainter 9085090 Advanced DB Master 724 5 Tejon St Colorado Springs CO

| 24 |Harris PinPaointer | 9085094 Handley Computer Corp 195 Eldorado Springs Dr Boulder co

| 25 |Harris PinPainter | 9085712 TurboPower Software Co 4775 Centennial Blvd #114 Colorado Springs CO

| 26 |Harris PinPainter | 9085816 Animas Automation & Contrals 107 W 18th St Durango co

| 27 |Harris PinPainter 9086035 ARC Science Simulations 306 N Washingtan Ave Laveland co

| 28 |Harris PinPaointer | 9086070 Realfast Software Publishing 721 Granite St #8 Frisco co

| 29 |Harris PinPainter | 9086245 Starplay Productions Inc 5188 Sunshine Canyon Dr Boulder 0]

| 30 |Harris PinPainter | 9087543 Cybemetics Inc 743 Horizan Ct # 322 Grand Junction co

| 31 |Harris PinPainter | 9087887 Musick Intemational 113 Centennial Plaza Buena Vista co

| 32 |Harris PinPainter | 9086425 Compulink 457 Spring Beauty Dr Silverthorne co

| 33 |Harris PinPainter | 9089051 Data YWest Corp 1061 E 2nd Ave Durango 0]

| 34 |Harris PinPainter | 9090118 Alpha Byte Systems Inc 910 Rescola Ave Silverthorne [#0]

| 35 |Harris PinPaointer 9090423 Eagle Computer Systems 120 E 3rd St Eagle co

14 [« [b b1l Excelk 141
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10) From the Excel menu, select File -> Save As.
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11) You will be presented with a screen like this:

Save in:

o

Hiskory

«'

Iy Documents

Favorites

I @ My Documents

2 x|

T« ®E @ X - Teds -

_ My eBooks
= My Pictures
1My Received Files ExceIG.csv

EExcelb.csv
Exu:elu:.u:sv
ExceID.csv

ExceIH.csv
ExceIK.csv

Save as bype: |CSY (Comma delimited) (*.csv)

=
=

E Save I
Zancel |

12) Save the file as a CSV type file.

13) Launch Act!

14) From the Act! menu select File -> Data Exchange -> Import.

15) You will be shown this screen:
Import Wizard

Thiz wizard wall import data from another file into the
currently open databaze.

“What tupe of file do pou want o impaort’?

File tepe: AN

Mate: | yau da nat zee the file type that pou

want, you may need to convert your existing
file to a delimited test file.

Filename and locatiorn;

C:ADocuments and Settingzhmile. _I

% Back | Ment » | Finizh I Cancel

16) Select Text — Delimited as the file type.
17) Click on the button to the right of the text box listing the file name.




18) You will be shown this screen:

Loak jn: Ia by Documents j - £ E9-

[ acT
] My eBooks

@My Pictures
= My Received Files

File name: | Open I

Files of tope: RN I W Cancel

4
19) Select Text — Delimited (*.csv) as the type of file. The two available options
are very similar. Make sure you select the one that ends in “(*.csv)”.

20) Select The CSV File You Saved in Excel by clicking on it in the list of files.

21) Click Open.

22) Click Next >.

23) You will be shown this screen:
Import Yizard

ACT! databazes can contain contact recards and group
records. ‘Wwhat kind of records do pou want to import?

¥ iContact recards ol

" Group records only

€ Contact and group records

To wiews additional import options, click the Options button.

Optionz... |

< Back Hest > | Finizh I Caricel

24) Select the Contact records only option.
25) Click Options....




26) You will be shown this screen:
Import Options EI

— Select field separator

Delimited text files are created with a zpecific
character separating each field of a record. what
twpe of character was uzed for vaur file?

* Comma

i~ Tab

— Select character zet

YWhat character zet was uzed to create
waLr file?

Character et IWiﬂdDWS EN j

— Impart the first record?

Some delimited text filez uze the first record to contain the
field names rather than actual data. |n thiz caze, you
may nok want to import the first record.

Iw “fes, import the firet recaord

'; Cancel |

27) Remove the check next to Yes, import the first record.
28) Click OK.
29) Click Next >.
30) You will be shown this screen:
Import Wizard

ALCT! allows wau ta uze predefined map files to help pau impart
data from ather applications. Theze map files are predefined
templates that match the database hieldz from other
applications to figlds in an ACT! databaze.

Do pou want o use a predefined map file?
i |ze predefined map

& Dan't use predefined map

Select the map vou would like to use when you impart
wour data.

ECCO -
FedEx
Goldkdine

Janna Contact
b amimizer

Orgarizer ;I

< Back Ment » | Finizh I Cancel




31) Make sure the Don’t use predefined map option is selected.
32) Click Next >.
33) You will be shown this screen:

Import Wizard
COMTACT MAP
The data being imported must be mapped to the individual
fields in the currently open database.
b ap this field T o thiz field
A ccto -
Company Mame
Divigion M arme
Address
City City
State State
ip Zip -
1 | | 3
4= | FEezet | Load Map | Save Map |
Fecord 1 Default map.
< Back | Hedt » | Finizh | Canicel |

34) The fields have been mapped as shown below. If you wish to change the field

mapping, you may do so at this time.

Act Field Contents

Company Company name

Address 1 Physical street address
City Physical city

State Physical state

Zip Physical zip

Home Address Mailing address

Home City Mailing city

Home State Mailing state

Home Zip Mailing zip

Phone Phone number

Alt Phone Toll free phone number
User 1 “Technology PinPointer”
User 2 # of employees

User 3 Plant size in sq ft

User 4 Employment change over the last 3 years
User 5 Product description

User 6 Annual sales

User 7 Primary SIC code

Web Site Web site address

Ticker Symbol Stock ticker symbol
Contact Full name of first contact




Title

2" Contact
2" Title
3" Contact
3" Title

35) Click Finish.

Title of first contact

Full name of second contact
Title of second contact
Full name of third contact
Title of third contact

36) The PinPointer® data will now be imported!



	Act FieldContents

